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1 Introduction 

1.1 Integris Timetabling Module 

The Timetabling Module enables schools to produce the best possible comprehensive student, 
staff and room timetables using the information entered in the Administration module and 
Timetabling module.  Student preferences may be entered into the system either individually or in 
bulk.  Users may choose to enter many or few constraints and, using the auto-scheduler, the 
system will produce the best possible timetable given the above constraints.  If the timetable does 
not fit the needs of the school it may be manipulated manually or constraints relaxed or tightened 
and the auto-scheduler run again to produce the best possible timetable for the school. 
 

1.2 Key Benefits 

Integris Timetabling Module contributes to school effectiveness in the following ways. 
 

¶ It helps teachers and managers to carry out their responsibilities. 

¶ It reduces workloads for busy teaching and administrative staff. Data entry of preferences via 
the keyboard or mouse is simple and straightforward.  

¶ It avoids the need for time-consuming manual statistical calculations. A range of standard 
reports is included with the system. 

 

1.3 Key Features 

Integris Timetabling Module includes the following key features.  It 
 

¶ Is simple to set up and run 

¶ Supports all aspects of timetabling staff, student and rooms within one simple, easy-to-use 
interface 

¶ Includes a wide range of standard reports.  

¶ Includes the ability to import information from other software applications, thereby facilitating 
data sharing where required. 

¶ Can be configured for/by the people using it, including the descriptions of any codes used, for 
example for subjects, faculties and so on. 

¶ Has seamless links with the other RM Management Solutions products, avoiding the need for 
any re-entering of school, staff or student data. 
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1.4 How to Use this Manual 

This manual describes the features and facilities available in Integris Timetabling Module, a 
component of the Integris suite of software. 

You should refer to this guide if you are responsible for setting up or maintaining information about 
your school, staff or students.  It describes how to enter information, print reports and keep the 
timetable up to date.  The sections are listed below. 
 

Section 1: Introduction to Integris  This section describes the product and its 
benefits.  It also describes the contents of this 
guide. 

Section 2: Getting Started This section explains the basic functions with 
which you need to become familiar as a new user 
of Administration Manager and the Timetabling 
Module.   

Section 3: Maintaining Parameters This section explains how to set up and maintain 
parameters.  Use the Parameters functions to 
define the lists that users see when entering data. 

Section 4: Maintaining School Details This section details how to set up a new 
academic year in the School Diary, recording 
events and closed days in the calendar, and 
printing term/year views of the school diary. 

Section 5: Timetable Setup This section describes how to set up details of 
your timetable 

Section 6: Student Preferences This section details how to enter either 
individually or in bulk the subject preferences of 
students. 

Section 7: Grid Modelling  This section defines how to manipulate a grid 
either manually or by using the auto-scheduling 
process. 

Section 8: Timetable  This section describes how to allocate staff and 
rooms to a previously saved Timetable.  

Section 9: Student Course  This section defines how to maintain a current 
timetable by adding students to a timetable. 

Section 10 Recommendation Data Entry  This section describes how teachers can make 
future subject recommendations for existing 
students. 

Section 11: Reports  This section describes how to produce the various 
standard reports that are supplied with the 
Timetabling Module.  

Section 12: Glossary This section contains a glossary of timetabling 
terms and concepts. 
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Section 13: Index This section provides the location of itemised 
timetabling functionality outlined throughout this 
document. 

Section 14: Support This section provides information on accessing 
support for using the Timetabling module. 
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2 Getting Started 

2.1 Installing Integris 

The facilities available in the Timetabling module are covered in this manual.  Also included are 
relevant features, to creating a timetable, of the Administration Manager. 
 

2.2 Logging On and Exiting 

2.2.1 Logging On 

To log onto the system following the successful installation of the software, either: 

¶ Double-click on the Integris icon on your desktop; 

¶  

¶ Click on the Windows Start button; 

¶ Select the Programs option; 

¶ Select the RM Management Solutions option; and 

¶ Select the Integris option. 
 
If you are using Integris for the first time after its initial installation you will be provided with a user 
name and password to log onto the software.  Should you experience any difficulties please 
contact your support centre. 

¶ In the User Name field, enter your User Name. 

¶ In the Password field, enter your password. 

¶ Users of the software can be set up with individual user names and passwords. See 
Administration manual for details. 

¶ Click the Login button or press <Enter> on the keyboard. You will now be able to access the 
system. 

 
If you are using a new data file, the system displays the School Details window.  The main details 
of the school must be completed before any processing can take place.  See the Administration 
Manager manual for further details. 
 

Note: When you log on to the system, a validation routine is automatically run to ensure 
that the data file you are using is synchronised with its associated partner file.  If 
there is a discrepancy, a warning message is displayed.  If this occurs, contact your 
support centre for guidance. 
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2.2.2 Exiting Integris 

When you have finished processing your data, use the following procedure to exit the system. 
 

¶ Click on the File menu in the top left hand corner of the window. 

¶ Click on the Exit option.  The system displays a message asking if you are sure. 
 

 
 

¶ Confirm your choice. 

¶  

An alternative to this method is to simply click on the cross (X) in the top right hand corner 
of the title bar.  This acts as a Close button, and also prompts the user to confirm that they 
wish to exit. 

 

 
 

 

2.2.3 Changing your Password 

(File>Password) 
 
You should change your password at regular intervals for security purposes.  To change your 
password 

¶ Click on the File menu in the top left hand corner of the window. 

¶ Click on the Password option.  The Change Password window is displayed. 
 

 
 

Minimize Close 
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¶ Enter your current password. 

¶ Tab to the New Password box.  Enter the new password you want to use. 

¶ Tab to the Verification box and enter the same password again. 

¶ Click OK to accept the new password. 

Note: You are warned if the text you enter in the Verification field is not the same as the 
New Password you entered.  If you see the warning message, click OK and re-enter 
the new password in the New Password and Verification boxes. 

 

2.3 Integris Help Function 

(Help>Help Contents & Index) 
 
The Integris Help system is located at the top of the screen.  
 

¶ Click on Help to open the Help menu.  

¶ Click on Help Contents and Index.    
 

 
 
On launching Integris Help, users are presented with a list of Help Areas.  These areas relate 
directly to the currently installed module set.  
 

 
 
By selecting a Help Area from the list, users gain access to the related Help files, with content and 
search facilities available.  The system allows you to narrow the field of the search, thus retrieving 
the necessary information with greater ease. 
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2.4 General Sidebar Functions 

The core features in Integris are grouped on the General sidebar.  
 
 
 

¶ School Details ï used to enter and maintain information 
relating to the school, as well as accessing the School Diary. 
 
 

¶ Student Details ï used to enter and maintain information relating to the 
students associated with the school. 
 
 

¶ Staff Details ï used to enter and maintain information relating to the 
staff associated with the school. 
 
 

¶ Groups ï used to enter details of staff and student groups. 
 
 

¶ Parameters ï used to set up and maintain a range of Fields, codes and 
descriptions to be used throughout Integris. 
 
 

¶ Control ï used to set up options for Integris Administration and to import 
information required from another file or system. 
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2.5 Timetabling Sidebar Functions 

The Timetabling features of Integris are grouped on the Timetabling sidebar. 
 

 
 

¶  Student Course - displays for each student a list of preferences, the 
studentôs timetable and the relevant grid for the student with member teaching 
sets highlighted. 
 
 

¶ Timetable - displays the current whole school timetable that may be 
filtered by year, cycle, schedule, grid or department. 
 
 

¶ Grid Modelling - allows the user to either manually manipulate the grid 
or define constraints and use the auto-scheduler to model the grid or a 
combination of both. 
 
 

¶ Preferences - refers to the entry of studentôs subject preferences which 
may be entered either on an individual or group basis. 
 
 

¶ Reports - allows the user to access a list of timetable reports divided 
into three main areas: Data Validation Reports, Planning and Preparation 
Reports and Operational and Maintenance Reports. 
 
 

¶ Timetable Setup - allows the user to define all aspects of the timetable 
prior to creation of a new timetable.  Timetable Setup can be completed at any 
time for future timetables. 
 
 

¶ Exam Scheduler ï is an independent module that allows for school 
planning / scheduling of extensive invigilated assessments (examinations) in a 
single exam session.  A separate User Manual exists for Exam Scheduler 
navigation. 
 
 

¶ Data Entry ï allows the user to make future Subject recommendations 
for existing students. 
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3 Maintaining Parameters 
(General>Parameters) 
 
Use the Parameters functions to define the lists that users see when entering data.  
 
This section will only outline parameters that are used by the Timetabling module.  These are 
Faculties, Departments, Room Type, Rooms, Subject Area, Subject Classification, Subject Type 
and Subjects.  For information on all other parameters, please consult the Administration Manager 
manual. 
 
The Parameters functions are located on the General sidebar.  Once you have set up a parameter, 
you cannot delete it if it is used by any of the existing records in your data file. 
 
To access the parameters, click on the Parameters icon.  The system displays the Administration 
Parameters window.  To locate a specific parameter, type the first few characters of the parameter 
name.  The system will highlight the parameter on the list.  Press <Enter> to open the parameterôs 
window and view parameter details. 
 

 
 

Before starting to use the system, you need to set up the parameters you intend to use. 
 

You can use the same procedure to set up many of the parameters used throughout Integris as 
they consist of a code, a school code and description.  Some will have been set up for the school.  
 

WARNING: Changing some parameters will affect the integrity of the schoolôs data.  

Some parameters contain a value óNot Specifiedô.  Do not change any existing óNot 
Specifiedô parameters. 
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3.1 Maintaining Parameters required by the Timetabling module 

(General>Parameters) 
 
You may need to set up some or all of the above parameters, depending on the structure of your 
school and other factors.  These parameters need to be set up in the following sequence, as some 
require data from another parameter.  Those parameters in the list followed by an asterisk * are 
essential to the Timetabling module. 
 

¶ Faculties 

¶ Departments * 

¶ Room Type 

¶ Rooms * 

¶ Subject Area 

¶ Subject Classification 

¶ Subject Type 

¶ Subjects * 
 

Note: Subject Type and Subject Classification are essential for reporting to the School 
Curriculum and Standards Authority in Western Australia. 

 

3.1.1 Faculties 

(General>Parameters>Faculties) 
 
Some schools have a structure that includes faculties.  These can be set up in the software. 
 

¶ In Parameters, click on Faculties. 

¶ The Faculties window will open. 
 

¶ Right click in the Description column to access the following menu. 
 

 
 

¶ Choose Add/Edit Parameters and enter the details of a faculty.  Alternatively, use the 
Add function on the menu bar.  

 
The maximum length of the code is determined by the number entered in the Parameter Code 
Digits field located in the General sidebar > Control > Preferences > General tab.  
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¶ Add the new faculty.  There is no need to enter a School code.  Add additional faculties as 
required. 

 

 
 

3.1.2 Departments 

(General>Parameters>Departments) 
 
If your school structure includes departments, you may wish to set up details of departments in 
Parameters.  Once they are set up, you can amend or delete them when necessary. 
 

Note: if you wish to record details of the faculties and heads of departments with the 
departments you add, make sure you have already set up the faculties in your school and 
entered Staff Details for the heads of departments.  See the Administration Manager manual 
for details about holding staff information.  However, there is no requirement to enter 
faculties, where a school does not have faculties.  

 

Adding a Department 

To set up departments: 
 

¶ In the Parameters window, double click on the Departments icon.  The system displays the 
Departments window 
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¶ Click the Add button.  The Add Department window is displayed. 
 

 
 

¶ Enter the details for the department you are adding.  Use the magnifying glass to locate the 
staff member who is Head of Department.  Staff names are set up in Staff Details. 

¶ Click OK to accept the details and add the department to the list. 

¶ Continue to add further entries as required. 

¶ Click Close when you have finished adding departments. 
 

Editing or Deleting Departments 

To amend a department, select it in the list in the Departments window and click on the Edit 
button.  You can then access its details, make any amendments and accept them  
 

To delete a department, select it in the list and click on the Delete button.    You need to 
confirm the deletion.  Once you do that, the department is removed from the list.  Departments that 
are in use cannot be deleted. 
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Copying a Department Parameter 

Use the Copy Selected Parameter  button to clone the fields of another department you have 
set up.  
 

¶ Click on the name of the department you want to copy and click the Copy Selected Parameter 
button.  

 

 
 

¶ Change any fields as required.  

¶ Click OK to save. 
 

Printing a List of Departments 

To print a list of departments, click on the Print button.  
 
 

3.1.3 Room Type 

(General>Parameters>Room Type) 
 
If you wish to allocate a room type to each of the schoolôs rooms, use Parameters > Room Type to 
create each type.  

¶ Use the Add function  to add a room type. 
 

 
 

¶ Enter the details of the new room type 
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¶ Click OK to save. 
 

3.1.4 Rooms 

(General>Parameters>Rooms) 
 
You will need to set up details of the rooms in your school.  Once they are set up, you can amend 
or delete them when necessary. 
 

 
 
 

Note: If you wish to record details of the room type with the rooms you add, make sure you 
have already set up the Room Types in Parameters.  

 
 

Adding Rooms 

To set up/add rooms: 
 

¶ From the Administration Parameters window, double click on the Rooms icon.  The Rooms 
window is displayed. 

¶ Click on the Add button.   The Add Room window is displayed. 

¶  
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¶  
¶  

¶ Enter the details for the room you are adding. 

¶ Click OK to accept the details and add the room to the list. 
 

Copying a Room Parameter  

Use the Copy Selected Parameter button to clone the fields of another room you have set up.   
 

¶ Click on the name of the room you want to copy and click the Copy Selected Parameter 
button.  

¶ Change any fields as required.  

¶ Click OK to save. 
 

Printing Details of Rooms 

To print a list of rooms, click Print.  The following is a sample report on rooms. 
 

 
 

Editing or Deleting Rooms 

To amend a room, select it in the list and click on the Edit button.   
You can then access its details, make any amendments and accept them.  
 

To delete a room, select it in the list and click on the Delete button.    
You need to confirm the deletion.  Once you do that, the room is removed from the list. 
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3.1.5 Subject Area 

(General>Parameters>Subject Area) 
 
Your school may choose to use Subject Area to group subjects.  For example, you may group 
subjects in Learning Areas. 
 

Adding a Subject Area 

¶ Click on Add   
 

 
 

¶ Enter the required details 

¶ Click OK 
 

Editing and Deleting Subject Areas 

To amend a subject area, highlight the appropriate record and click on the Edit Record button.  

  You can then access its details, make any amendments and accept them.  
 

To delete a subject area, highlight it and click on the Delete button.    You will need to confirm 
the deletion.  Once you do that, the subject area is removed.  Subject areas that are in use cannot 
be deleted.  If you attempt to delete a subject area that is in use the following message will be 
displayed. 
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Copying a Subject Area Parameter 

Use the Copy Selected Parameter button  to clone the fields of another Subject Area you 
have set up.  
 

¶ Click on the name of the Subject Area you want to copy and click the Copy Selected 
Parameter button.  

¶ Change any fields as required.  

¶ Click OK to save. 
 

3.1.6 Subject Classification 

(General>Parameters>Subject Classification) 
 
Subject Classifications are ways of identifying like subjects.  For example, Western Australian 
users may assign the appropriate classification to all School Curriculum and Standards Authority 
accredited subjects. 
 

 
 

Adding Subject Classifications 

¶ Click on Modify/Add Parameters button  to add subject classifications. 

¶ Click on the first blank line and enter appropriate details. 

¶ Click OK to save the classification. 
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Editing/Deleting Subject Classifications 

To amend a subject classification click, on the Modify/Add Parameter button.  You can then 
access its details, make any amendments and accept them.  
 

To delete a subject classification, highlight it and click on the Delete button.  You will need to 
confirm the deletion.  Once you do that, the subject classification is removed.  

Note: Only subject classifications that have been added by users may be edited or deleted.   

 

3.1.7 Subject Type 

(General>Parameters>Subject Type) 
 
Subject Type is a further classification of a subject.  For example, Western Australian users may 
classify subjects as COS, CEP or VETCOS.  These are essential if users are intending to report to 
the Western Australian School Curriculum and Standards Authority. 
 

   
 

Adding Subject Types 

¶ Click the Modify/Add Parameters button  to add subject types. 

¶ Click on the first blank line and enter appropriate details. 

¶ Click OK to save the subject type. 
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Editing and Deleting Subject Types 

To amend a subject type: 

¶ Click on the Modify/Add Parameter button.  You can then access its details, make any 
amendments and accept them.  

 
To delete a subject type:  

¶ Highlight it and click on the Delete button.   You will need to confirm the deletion.  Once you 
do that, the subject classification is removed.  

 

3.1.8 Subjects 

(General>Parameters>Subjects) 
 
You may need to set up details of the subjects taught in your school.  Once they are set up, you 
can amend or delete them when necessary.  Each subject can later be linked to one or more 
teaching sets. 
 

Adding Subjects 

To set up/add subjects: 
 

¶ From the Administration Parameters window, double click on the Subjects icon 
 

 

Note:  In the Northern Territory, this window may also display SSABSA information. 
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¶ Click on the Add Record button.   The Add Subject window is displayed. 
 

 
 

¶ Enter the details for the subject you are adding. 

Note: When you select a department, details of the faculty and head of department are 
automatically completed if the details have been set up in the Faculties and 
Departments parameters. 

¶ Click OK to accept the details. 
 

Editing and Deleting Subjects 

To amend a subject: 

¶ Find it using the Find Record button   

or the blue Previous Record/Next Record arrows   

or by typing the subject code in Search (by Subject Code)  

¶ Click on the Edit Record button.  You can then access its details, make any amendments 
and accept them.  

 
To delete a subject: 

¶ Find it using the Find Record button   

or the blue Previous Record/Next Record arrows   

or by typing the subject code in Search (by Subject Code)  

¶ Click on the Delete button.  You need to confirm the deletion.  Once you do that, the subject 
is removed.   
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Note: Subjects that are in use cannot be deleted.  If you attempt to delete a subject that is 
in use, the following message will be displayed. 

 
 
 

3.1.9 Toggling Locked Status 

(General>Parameters) 
 
Parameters cannot be edited or deleted if they are locked.  However, they can be unlocked if you 
need to edit or delete them. 
 
To unlock a parameter: 

¶ When viewing a parameter list, click on the line that you wish to unlock 
 

 
 

¶ Click on the Toggle Lock Status button.    

¶ Alternatively, right click within the pane and click Toggle locked status.   

¶ Confirm that you wish to change the locked status.  The value in the Locked column changes 
to NO. 
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To change the status back to ólockedô, re-select the line and click on the Toggle Lock Status 
button again 

Some parameters, for example Departments, have a checkbox to indicate a locked status. 

 
 

3.1.10 Changing Active Properties of Parameters 

(General>Parameters) 
 
When parameters are first set up, they are active.  You are not obliged to use all the parameters.  
You can make a parameter inactive, thereby switching it off, so it is not available to users.  You can 
make an inactive parameter active again at a later date if required.  

Note: You can only make a parameter inactive if it is unlocked and if it is not being used. 
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Making a Parameter Inactive 

¶ When viewing a parameter list, click on the line/s that you wish to make inactive. 
 

 
 

¶ Click on the Toggle Active Property button  or right click on the parameter and select 
Toggle Active State from the menu.  The system displays a message asking you to confirm 
this action. 

¶ Select Yes to proceed.  The system reverses the Active state of the selected parameter/s.  The 
value No is shown in the Active column. 

 

 

Note: To make the parameter active again, re-select the line and click on the Toggle Active 
Property button/menu item. 

You can change the active setting for more than one parameter at a time. 
 

¶ To select all parameters click on the first entry, hold down the <Shift> key and then click on the 
last entry.  

OR 

¶ To choose selected parameters hold down the <Ctrl> key and click on the required parameters. 

¶ Click on the Toggle Active Property button/menu item. 
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3.1.11 Printing Parameters 

(General>Parameters) 
 
To print a Parameters list: 

¶ When viewing a parameter list, click on the Print Parameters button.  The system displays 
the Report Destination window. 

¶ Select the destination for the printed report.  
 

 
 

3.1.12 Setting a Parameter as the Default 

(General>Parameters) 
 
A default parameter will appear automatically in the chosen field. 

¶ Highlight the appropriate parameter 

¶ Click on Default.  
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4 Maintaining School Details 
(General>School Details) 
 
The School Details function enables users to enter details relating to the school and the 
timetable.  It holds, among other things, details of school sites, the school calendar and timetable 
cycles.  The School Details function is found on the General sidebar.  To access school details 
click on the School Details icon in the General sidebar.  The School Details window is displayed.  
 

 
 
By default, this window shows the Summary details of the school.  Click on the other buttons at the 
top of the window to view more details. 
 

 Sites 

 Directory  

 School Activity  

 UDIs (User-defined Information) 

 Print school details    

 Send a letter   

 Send an e-mail    

 Calculate the Current Roll    

 Display the school calendar   

 Timetabling Periods 
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Only Sites, School Calendar and Timetabling Periods will be discussed here as these relate to 
creating a timetable.  For more information on other areas, please refer to the Administration 
Manager manual. 
 

4.1 Maintaining Site Details 

(General>School Details>Sites) 
 
Some schools are located on more than one site.  Use the Additional Sites tab to record the details 
of any further sites at which your school is located, or details of affiliated organisations.  Any sites 
that are defined in School Details may be made available to the Timetabling module as a separate 
campus.  It is suggested that only separate sites are defined in School Details. 
 

4.1.1 Adding an Additional Site   

(General>School Details>Sites) 
 

¶ Click on Edit School Details.  

¶ Click on the Additional Sites tab.   
 

 
 

¶ Click Add.   
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¶ Enter data in the fields as required. 

¶ Click on OK. 
 

4.1.2 Editing Sites 

(General>School Details>Sites) 
 
To edit the details of a site: 

¶ Click Edit School Details.  

¶ Click on the Additional Sites tab.   

¶ Click on the site record you wish to edit. 

¶ Click on the Edit button. 

¶ Edit the record as required. 

¶ Click on OK to save the changes. 
 

4.1.3 Deleting a Site 

(General>School Details>Sites) 
 
Additional sites can be deleted if they are no longer required.  To delete a site 

¶ Click on the Edit School Details button.  

¶ Click on the Additional Sites tab.   

¶ Click on the site record to be deleted. 

¶ Click on the Delete button  

¶ Confirm the deletion. 
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4.2 Setting up the School Year 

(General>School Details>School Diary>Set up School Year)) 
 
The school year must be defined before attempting to create a new timetable.  This may be done 
at any time and for any number of years in the future and does not affect the current school year.  
A default timetabling year will be created to match the school year.  The start and end dates for the 
timetabling year may differ from the school year but must match the Lesson Attendance year 
exactly. 

Note: Before creating a new school year it is essential that you back up your data file and 
check that no-one else has already created that year.  

¶ Click on Display School Diary.  

¶ Click on Set up School Year.  The Diary Setup window will open.  It contains three 
functions 

 

 
 

¶ Select Set up year structure.  

¶ Click OK.   
 
The School Year window will open.  It displays fields where you can enter the school year, closure 
codes and descriptions, and term dates. 
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¶ Enter the next yearôs school year in the School Year field and <Tab>.  This prompt will appear. 
 

 
 

¶ Click Yes.  The new year will now be displayed. 
 

 
 
The ñI: Insetò closure code and description can be changed to reflect terminology used in your 
school, for example to ñS: School Dev.ò  If you are using an Integris Attendance or Lesson 
Attendance module, do not change the Closure, Holiday and Open codes or descriptions. 
 

¶ Click on the Add Term button  to enter the first termôs details.  The School Term window 
will open.  

¶ Add details of terms, one at a time. 
 

 
 

Either  

¶ type the date in the format DD/MM/YYYY  

Or  



 Integris Timetabling Manual.docx 8-Jan-14 

Page 4-7 

© 2014 Civica Education Pty Ltd 
 

¶ Use the Activity Calendar button  to open the date selector.  Locate the appropriate date.  
Use the blue arrows to advance/go back a month.  Double click on the required date to enter it 
in the School Term window. 

¶ Press OK to save the termôs data.  

¶ Continue adding terms until all terms are entered for the following year. 
 

 
 
If you make a mistake in entering a termôs details, highlight the term and click on the Edit button. 
Amend the details and press OK to save the amendment. 
 

¶ Click on OK to save the new school year set-up.  
 
The system generates the next yearôs calendar and displays it so the user can enter any known 
professional development days, closed days, and holidays.  It is important that holidays and 
other closed (student-free) days are entered in the diary as soon as they are known.  The 
data is used in other modules such as Lesson Attendance and Timetabling. 
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4.3 Creating Timetable Periods 

(General>School Details>Timetabling Periods) 
 
A default timetabling period will be created automatically which spans the whole timetabling year.  
Other timetable periods such as terms, semesters, learning blocks etc may be created. The user 
must enter the start and finish dates of the timetable periods.  Dates must be entered prior to 
creating a new grid if the school has timetable periods other than the entire year.  
 

¶ Click on Timetabling periods button  will display the following window 
 

 
 

¶ Click on  to create semester periods 

¶ Click on  to create term periods 

¶ Other timetable periods may be created by clicking Add  
 

 
 

¶ Enter an appropriate Code and Description  

¶ Either type the dates in the format DD/MM/YYYY or use the Activity Calendar button  to 
open the date selector.  Locate the appropriate date.  Use the blue arrows to advance/go back 
a month.  Click on the required date and then OK 

¶ Press OK to save the termôs data.  
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Editing a Timetabling Period 

¶ Highlight the appropriate period and click on Edit.  

¶ Edit the appropriate fields.  

¶ Click OK. 
 

Deleting a Timetabling Period 

¶ Highlight the appropriate period and click on Delete . 

¶ A warning message will appear asking if you are sure. 

¶ Click the appropriate answer. 
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5 Timetable Setup 
(Timetabling>Timetable Setup) 
 
Many of the following functions, that need to be completed before creating a new timetable, will 
only need to be done once a year and may only require checking at the commencement of a new 
timetable year.  These functions may be modified during the year if necessary. 
 
The set up functions are contained within Timetable Setup on the Timetabling sidebar.  The 
following screen shows the Timetable Setup menu: 
 

 
 

5.1 Campuses 

(Timetabling>Timetable Setup>Campuses) 
 
Campuses are defined as either physically separate locations of school buildings or logical groups 
within the school that may employ the same or different timetabling cycles.  Physically separate 
campuses may be stored within school details and accessed through the timetable module.  
Campuses, either physical or logical, may change from year to year so are linked to a timetable 
year when attached to a timetable grid.  The campuses once created may be flagged as inactive, 
and therefore not available to users, or deleted.  However, a campus cannot be deleted if it has 
been linked to a grid. 
 
A physical campus should first be defined within school details on the general sidebar before 
making it accessible to the timetable.  Logical campuses should be created within the Timetabling 
module as these campuses are only for use within the timetable.  Campuses may be added, 
edited, deleted, made active or inactive and locked.  
 
Clicking on Campuses will display the following window  
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5.1.1 Adding a Physical Campus 

(Timetabling>Timetable Setup>Campuses) 
 

¶ Click on sites.  

¶ Click Yes. 
 
Any sites that have been entered in the School Details will now be available.  Any that are not 
required for Timetabling purposes may be deleted. 
 

5.1.2 Adding a Logical Campus 

(Timetabling>Timetable Setup>Campuses) 
 

¶ Click on Modify/Add parameters.  

¶ Enter appropriate information. 

¶ Click OK. 
 

5.1.3 Editing a Campus 

(Timetabling>Timetable Setup>Campuses) 
 

¶ Click on Modify/Add parameters.  

¶ Amend appropriate information. 

¶ Click OK. 
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¶  

5.1.4 Deleting a Campus 

(Timetabling>Timetable Setup>Campuses) 
 

¶ Highlight the appropriate parameter. 

¶ Click on Delete . 

¶ Confirm your choice. 
 

5.1.5 Making the School Year the Default 

To save selecting the appropriate school year every time the Campus screen is opened, the user 
can make a particular school year the default, so that the chosen school year is displayed every 
time the window is opened. 
 

¶ Select the appropriate School Year from the drop down list 

¶ Click on the green tick.  
 

5.2 Cohorts 

(Timetabling>Timetable Setup>Cohorts) 
 
A cohort is a group of students who will be timetabled within a grid.  A cohort may consist of a year 
level (for example Year 8), a combination of year levels (for example the Upper School) or another 
specific group (for example an ESL group).  Cohorts may be associated with more than one 
timetabling period.  For example, the same Year 9 cohort may be associated with Semester 1 and 
Semester 2.  Students may also be assigned to more than one cohort. 
 

Students will be selected for a cohort using the student FIND tool or by cloning a cohort from a 
previous timetabling period and renaming it.   
 

Students may be added to the cohort as required.  They may also be removed from the cohort if 
necessary.  However if the student has subject preferences or teaching sets attached the user will 
be warned of this when removing the student.  If a student is removed from a cohort, the class 
totals will reflect this change and the student will be removed from any associated teaching sets. 
 

Students listed on the admissions roll may be added to cohorts at any time.  However, as a student 
is moved from admissions to the current roll, the user will not be prompted to add the student to a 
cohort even if he/she is not already in a cohort.  Student preferences may also be added for 
students on the admissions roll through Preferences provided the student has been included in a 
cohort. 

Note: Users entering students on the current roll will be prompted to select a cohort at 
time of enrolment.  Users moving students to the former roll will be prompted to 
remove the student from the cohort.  However, the user will also have the option to 
have the leaving student remain in a current cohort and these students will be 
highlighted in red to distinguish them from current students. 

Former roll students who are due to come back to the school the following year are able to be 
added to a cohort and provided with a timetable. They will be labelled as ñleftò, and will appear in 
red text in the Cohorts window, and in the Student preferences window. This is in effect the same 
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situation as that which arises when a student leaves, but the user opts to leave them in their 
Cohort. When a Former student is re-instated, the ñleftò label will be removed. Checks will be made 
to ensure that when the student is re-instated, the attendance is updated appropriately, if the 
Lesson Attendance module is installed 
 

 
 

5.2.1 Adding, Editing or Deleting Cohort Names 

(Timetabling>Timetable Setup>Cohorts) 
 
Before students can be added to a cohort, the Cohort Name must be defined. 
 

Adding a Cohort Name 

¶ Select the appropriate School Year. 

¶ Adjacent to Cohort Name click on Add.  

¶  

¶ Enter the name and click OK. 
 

Editing a Cohort Name 

¶ Select the appropriate School Year. 

¶ Highlight the Cohort Name. 

¶ Click Edit.  
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¶  

¶ Enter new Cohort Name. 

¶ Click OK. 
 

Deleting a Cohort  

¶ Select the appropriate School Year. 

¶ Highlight the Cohort Name. 

¶ Click on Delete. 

¶  

¶ Click Yes. 

Note: A Cohort cannot be deleted if it is linked to a timetabling grid.  A warning message 
will appear if you try to delete a linked Cohort. 
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5.2.2 Adding or Deleting students in a Cohort 

Once a cohort name has been defined, students may be added to the cohort. 
 
(Timetabling>Timetable Setup>Cohorts) 
 

Adding Students to a Cohort  

¶ Select the appropriate School Year. 

¶ Highlight the appropriate Cohort name. 

¶ On the right hand side click on Add.  

¶ Using the FIND tool find the appropriate students to add to the Cohort. 

¶ If the selected students are, or student is, on the former roll then the following message will 
appear 

¶  

¶  
¶  

¶ Click on OK and the added students or student will appear in red. 

¶  

Deleting Students from a Cohort 

¶ Select the appropriate School Year. 

¶ Highlight the appropriate Cohort name. 

¶ Highlight some or all of the students listed on the right hand side. 

¶ Click on Delete.  
 

 
 

¶ Answer as appropriate. 

¶ If the selected students have subject preferences recorded the following warning message will 
appear 

 

 
 

¶ Answer as appropriate. 
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OR 

(General > Student details > Cohorts) 
 

Adding Students to a Cohort  

¶ Select the appropriate student ï it is possible to add a student from the current, admissions or 
former roll 

¶ Click on Change cohort  

¶ The following window will appear 

¶  

¶  
¶  

¶ Highlight the cohort you wish to place the student in and click on  

¶  

¶  
¶  

¶ Click on  
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¶  

Deleting Students from a Cohort 

¶ Select the appropriate student 

¶ Click on Change cohort  

¶ Highlight the cohort you wish to remove the student from in the ñMember ofò list and click 

 

Note: If a student is removed from a cohort in this way they will be removed from all 
preferences and teaching sets. 

 

5.2.3 Cloning a Cohort 

(Timetabling>Timetable Setup>Cohorts) 
 
Cohorts may be cloned from previous or future School Years as required.  The user will be 
prompted to enter a cohort name; students from the cloned cohort will automatically be added to 
the new Cohort. 
 

¶ Select the appropriate School Year. 

¶ Adjacent to Cohort Name click on Add.  

¶  

¶ Check the Clone box. 

¶ From the drop down list (includes all current, future and previous Cohorts), highlight a Cohort. 

¶ Enter a Cohort Name and click OK. 
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5.2.4 Students not in a Cohort 

(Timetabling>Timetable Setup>Cohorts) 
 
Users are able to check that all students have been assigned to a cohort.  When entering new 
students the user will be prompted to add the student to a cohort but may choose not to do so at 
that time. 
 

 
 

Adding Students not already in a Cohort to a Cohort 

¶ Click on Refresh list of students without a Cohort . 

¶ Highlight student(s) from the list 

¶ Highlight a Cohort. 

¶ Click Select.  The students will be added to the selected cohort. 
 
The list of students without a cohort may be printed by selecting the Print button. 
 

5.2.5 Printing a Cohort List 

(Timetabling>Timetable Setup>Cohorts) 
 
Cohort lists may be printed at any time after they have been defined. 

¶ Select the appropriate School Year. 

¶ Highlight the appropriate Cohort. 

¶ Click on Print . 
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¶ Choose the destination of the report. 
 

5.3 Timetable Cycles 

(Timetabling>Timetable Setup>Timetable Cycles) 
 
A timetable cycle is defined for each timetabling year and contains the details of the cycle dates 
and period structures the school will use.  The timetable cycle draws details from the school 
calendar and forms the connection to the Lesson Attendance Year.  
 

¶ Cycles may remain in use for a number of years or may change from year to year.  

¶ A cycle will be linked to the timetabling year via the grids that use it and may be cloned and/or 
edited for use in future years.  

¶ The number of days within a cycle is unlimited.  If a 5 day cycle is chosen the day names will 
default to Monday, Tuesday etc.  If any other cycle is chosen the day names will default to Day 
1, Day 2 etc.  The day names are editable if required. 

¶ Cycle details may be added progressively over time.  

¶ A row refers to a line on the timetable and this may be a teaching period or a break like recess 
or lunch. Therefore, six rows per day may indicate six teaching periods or any combination of 
teaching periods and breaks, for example four teaching periods and lunch and recess. 
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5.3.1 Adding a Timetable Cycle 

(Timetabling>Timetable Setup>Timetable Cycles) 
 
You may have as many timetable cycles as you require, but at least one must be defined for a 
school to create a timetable. 
 

¶ Select the appropriate school year. 

¶ Click on Add . 
 

 
 

¶ Enter a Cycle Name and Cycle Description.  The Number of Days refers to the number of days 
in the cycle.  Ensure that you fill in the number of rows per cycle day. 

¶ Click OK. 
 

5.3.2 Editing or Deleting a Timetable Cycle  

(Timetabling>Timetable Setup>Timetable Cycles) 
 
Timetable Cycles may be edited or deleted after they have been defined, but only before teaching 
sets have been placed in any grids linked to the cycle if editing or before linking grids to the cycle if 
deleting. 
 

Editing a Timetable Cycle Definition 

¶ Highlight the appropriate cycle. 

¶ Click Edit.  

¶ Amend the appropriate field(s). 

¶ Click OK. If you have Lesson attendance data attached to the cycle the following displays: 
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¶  

¶  
¶  

¶ Click Yes to continue or No to cancel. 

If you click Yes, the following message appears. 
 

 
 

¶ Click Yes to continue or No to cancel. 

¶  

¶ If you do not have Lesson attendance data attached to the cycle the following displays: 

¶  

¶  
¶  

¶ Click Yes to continue or No to cancel. 

¶  

Editing Timetable Cycles 

Timetable Cycles may be edited if the cycle dates differ to the school calendar only for future 
weeks.  You cannot edit weeks in the past. 
 

¶ Highlight the appropriate Timetable Cycle. 

¶ Click on the Timetable Cycle tab. 

¶ Click Edit.  
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¶ Click on the pencil  next to any date in the future. 

¶ Select a new date using the calendar. 

¶ All future weeks will be adjusted accordingly. 

¶ Click OK. 
 

Deleting a Timetable Cycle 

¶ Highlight the appropriate cycle. 

¶ Click on Delete.  

¶ Confirm your selection. 

¶ If the cycle has been attached to a timetable grid(s) the following warning message will appear. 
 

 
 

5.3.3 Defining Additional Cycle Information 

(Timetabling>Timetable Setup>Timetable Cycles) 
 
Once a Timetable Cycle has been defined, the user must add additional information to the cycle.  
Timetable Cycles are added automatically and come from the school calendar that was defined for 
the school year in General>School Details.  The user must define Master Period Structure, Room 
and Staff Availability. 
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Master Period Structure 

(Timetabling>Timetable Setup>Timetable Cycles>Master Period Structure) 
 
The maximum number of periods and the timing of these periods to be required by any cohort 
using the cycle must be defined.  Where cohorts use variations on the default structure, grid 
definition will allow masking of unused periods for a particular cohort. 

Note: The master period structure can be inserted at the time of cycle creation or at a later 
point if required. 

If the user would like to show breaks (for example lunch, recess and/or before or after school 
activities) these must be included when calculating the number of rows per day and then included 
when entering the timing of periods.  
 
Staggered lunch breaks across cohorts are allowed by defining those periods where some cohorts 
have lessons and some have lunch as teaching periods óTô.   
 

Adding or Editing Master Period Structure 

(Timetabling>Timetable Setup>Timetable Cycles>Master Period Structure) 
 

¶ Highlight the appropriate Timetable Cycle. 

¶ Click on the Master Period Structure tab. 
 

 
 

¶ Click Edit.  
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¶ Enter the start and finish times for each period or break (if you included breaks) for the first 
cycle day.  Make sure that any breaks are given the appropriate period type (B for break or 
recess and L for lunch) and periods that are in the afternoon are changed to PM.  This is 
essential for the correct functioning of the Lesson Attendance module. 

Note: A twenty-four hour clock is used to enter start and finish times of periods/breaks. 

If subsequent cycle days have the same start and finish times for periods/breaks, 
 

¶ Click on Copy Periods between Days . 
 

 
 

¶ Highlight the appropriate period details and the days you want to have copied. 

¶ Click OK. 
  






















































































































































































































































































































































































































































































































































































































